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1 About Graph Grabber 1.5.5 

Graph Grabber 1.5.5 enables users to recover the data points from a graph whose 

original source data has been lost (so only the rendered graph ‘image’ remains). Once 

these data points have been recovered the user has the option of either re-rendering the 

graph within the application, or exporting the raw data to a comma separated text file 

so that it may be imported into a third party spreadsheet or graphing software package 

for further use. 

The Graph Grabber GUI is intended to be fairly intuitive to use. Details of its various 

features are briefly described in the following sections. 

2 Installation 

The Graph Grabber installer can be downloaded from the Graph Grabber page on the 

Quintessa website (http://www.quintessa.org/FreeSoftware/GraphGrabber). It is 

then a very easy process to get the program running on a Windows machine. 

2.1 System Requirements 

Graph Grabber can be deployed on computer systems running Microsoft Windows XP 

or higher. At least version 2.0 of the .NET framework is also required (although the 

installer will redirect to the Microsoft website to download an update if necessary). 

2.2 Installing the Software 

Running the installer starts the install process. This file may need to be re-run if the 

system is prompted to perform a .NET update. 

The installation process is described by a number of on-screen instructions. Options 

(such as the installation directory) can be modified if preferred but this is not 

necessary. Clicking ‘Next’ through the wizard should complete the process in a few 

minutes. 

A dialog will appear to notify when the installation is complete. Shortcuts will have 

appeared on both the start menu programs list (under ‘Quintessa’ by default) and the 

Windows desktop. 

http://www.quintessa.org/FreeSoftware/GraphGrabber
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3 Running Graph Grabber 

Graph Grabber can be run from desktop shortcut or the start menu just as any other 

Windows program. All of its functions can be performed from one window, shown in 

Figure 3.1. 

 

 

 

Figure 3.1: ‘Grab Data’ tab in main window during image tracing 

3.1 Preparing to Trace an Image 

Graph Grabber can open most standard image formats (including *.jpg, *.bmp, *.gif, 

*.png) along with metafiles (*.emf, *.wmf). Graphs to be traced should be scanned 

and/or saved into an accessible folder before running the software. Metafiles are 

scaled to an appropriate size upon loading; to trace them at high resolution it is 

recommended that users export them to an image format (e.g. *.png) at the required 

size before running Graph Grabber using a third-party graphics package. 

Image Pane Data Tree Tools Panel Toolbar Tabs Menus 
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3.1.1 Loading an Image 

Images can be loaded by clicking the ‘Open Image’ button on the toolbar or ‘File’ 

menu. This will launch the Windows ‘Open File’ dialog. The image file should be 

selected by navigating to the appropriate folder, selecting the file, and clicking ‘Open’. 

       

 

Once the image has been loaded, it may be necessary to re-orientate it before tracing. 

This can be done by Cropping, Rotating and Zooming (below). 

3.1.2 Cropping 

If an image contains a large amount of irrelevant space around the graph proper it is 

possible to trim it in order to focus only on the relevant space. This is done with the 

‘Crop’ tool. 

 

The ‘Crop’ tool can be selected from the toolbar. Once selected, clicking and dragging 

the mouse over the image will draw a rectangle over it. Releasing the mouse will 

discard any parts of the image outside of the rectangle. 

It is possible to revert to the original image by Undoing Changes (see below) at any time, 

although any traced objects will be lost. 

3.1.3 Rotating 

Although Graph Grabber can trace skewed or angled images, it will always assume the 

left-most point of the x-axis to be the minimum end, and the bottom-most point of the 

y-axis to be the minimum end. Therefore the x-axis cannot be vertical and the y-axis 

cannot be horizontal. For these reasons, and to aid with viewing and tracing the image, 

it may be required to rotate the image. 
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The ‘Rotate’ tool can be selected from the toolbar. Once selected, clicking anywhere on 

the image will display a graphic containing a peg and four slots. Whilst holding down 

the mouse, dragging towards the North, East, South or West pegs will rotate the image 

by the appropriate amount (0°, 90°, 180° or 270° respectively), as shown in Figure 3.2. 

Releasing the mouse will then set the image in its new orientation. 

Images should be placed in an orientation so that the x-axis runs roughly left-right 

(low-high) and the y-axis runs bottom-top (low-high), although they needn’t be square 

to the window. Rotations can be performed any number of times without loss of any 

image attributes. It is therefore easy to return to the initial orientation, if required. 

 

Figure 3.2: Rotating the image by 180° with the ‘Rotate’ tool. It is no longer in the 
correct orientation 

The ‘Rotate’ tool can be de-selected by re-clicking its toolbar button or selecting 

another function. 



QRS-4004A-2, Version 1.5.5 

5 

3.1.4 Zooming 

Images will initially be loaded at their actual size, but this may not fill or fit within the 

window. Zooming in and out of the image allows the most efficient view from which 

to trace. 

 

The ‘Zoom In’ (+) and ‘Zoom Out’ (-) tools can be selected from the toolbar. When 

selected, clicking anywhere on the image will zoom in or out (by 10%) as required. The 

image can be returned to its original magnification at any time by selecting the ‘1:1 

Zoom’ button from the toolbar. 

When the image is larger than the image pane, scrollbars will appear at the 

side/bottom of the pane to allow access to all parts of image. These can be used by 

clicking the adjacent arrows or dragging the bar itself. 

The ‘Zoom In’ and ‘Zoom Out’ tools can be de-selected by re-clicking their toolbar 

buttons or selecting another function. 

3.1.5 Undoing Changes 

 

At any point, it is possible to return the image to its original state (at its original 

magnification and orientation without crops) by clicking the ‘Reset Background Image’ 

button on the toolbar. However, any graph objects (axes, data series) defined before 

this point will be lost. 

3.2 Recovering the Data 

To recover data from an image, three elements are required: an x-axis, a y-axis and one 

or more data series. In Graph Grabber, Setting the Axes is necessary before Adding Data 

Series. 

3.2.1 Setting the Axes 

Each axis is set by selecting the ‘Set X-/Y-Axis’ button in the ‘Tools’ panel on the left 

hand side of the ‘Grab Data’ tab. 
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When the appropriate ‘Set X-/Y-Axis’ button is selected, the axis can be traced by 

clicking and dragging the mouse from one end point of the axis to the other. A straight 

black line will appear over the image, showing the location of the traced axis. 

 

When the mouse is released, a dialog box will appear requesting the axis range. The 

minimum and maximum values of the axis (i.e., the values at the end points of the lines 

just drawn) are entered in the appropriate boxes, and the axis scale can be made 

logarithmic by checking the ‘Logarithmic’ option (this is unchecked, for a linear scale, 

by default). The values of the minimum and maximum must both be defined and 

cannot be equal, nor can the former be greater than the latter. Negative/zero values are 

not permitted for logarithmic scales. 

The x-axis is always assumed to run low-high left-right, and the y-axis is always 

assumed to run low-high bottom-top. For this reason it is important to ensure that the 

image is orientated correctly by Rotating the image first. It is not necessary for the axes 

to intersect, be orthogonal to one another, or lie square to the image pane. 

It is possible to remove or edit an axis at any time by right-clicking its entry in the data 

tree in the ‘Tools’ panel. The pop-up menu will allow re-entry of end point values (by 

typing in the appropriate box and pressing Enter) and the scale type (by selecting from 

a drop-down list), or the deletion of the axis (which will also delete all data series). 

Clicking ‘Edit End Points’ will bring up clickable nodes which can be dragged as 

described below under Moving Traced Objects. 

3.2.2 Adding Data Series 

Once both axes have been set, it is possible to trace data sets. This is done by clicking 

the ‘Add Data Series’ button in the ‘Tools’ panel on the left hand side of the ‘Grab 

Data’ tab. 

When the ‘Add Data Series’ button is selected, data points can be added to a series 

simply by clicking them in turn on the image pane. A linearly interpolated preview of 
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each data set is then superimposed on the graph image. The series can be ended by 

clicking the button (now labelled ‘Click To End Data Series’) again. Any number of 

data series can be added in the same fashion; each will be coloured differently.  

It is possible to modify a data series once it has been defined. This can be done by 

right-clicking on the series or data point entry in the data tree in the ‘Tools’ panel.  A 

series can be named by typing in the ‘Change Name’ box and pressing enter, and the 

colour can be changed by selecting from the colour dialog box opened when ‘Change 

Colour’ is clicked. The option to hide/show the line connecting the data points can be 

changed by clicking ‘Show Points Only’. Clicking ‘Remove’ or ‘Remove Point’ will 

delete the selected series or point. Clicking ‘Add Point Before’ or ‘Add Point After’ 

allows a single point to be added before/after the one selected in the series, simply by 

clicking the new point’s location on the image pane in the same manner as the initial 

series was defined. 

Clicking ‘Edit Points’ will bring up clickable nodes which can be dragged to modify the 

data series, as described under Moving Traced Objects, below. 

3.2.3 Moving Traced Objects 

It is possible to move a traced object once it has been drawn. This can be done by 

selecting ‘Edit End Points’/’Edit Points’ when right-clicking an axis/series in the data 

tree in the ‘Tools’ panel on the left hand side of the ‘Grab Data’ tab. Alternatively, the 

‘Select Node’ tool can be selected from the toolbar. 

          

When the ‘Select Node’ function is selected, all nodes (data points and axis end points) 

are shown as squares on the image pane. Moving the mouse over the pane will change 

the cursor to a hand. Nodes can then be moved by clicking and dragging them to their 

required position.  

The ‘Select Node’ tool can be de-selected by re-clicking its toolbar button or selecting 

another function. 

3.3 Re-rendering the Graph 

Once axes and at least one series have been defined, it is possible to re-render a traced 

graph by selecting the ‘Graph Data’ tab. 
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The traced data will automatically be plotted in the graph pane of the tab, see Figure 

3.3. Customising A Graph is then possible within the ‘Graph Options’ panel on the left 

hand side of the tab. 

 

Figure 3.3: ‘Graph Data’ tab with re-rendered plot. 

3.3.1 Customising A Graph 

Editing any attribute in the ‘Graph Options’ panel will automatically update the graph. 

Text (title/axis title/series title) is changed by typing in the appropriate text box and 

pressing enter. Tick mark sizes are changed by typing a number in the appropriate box 

and pressing enter. Colours (background/legend/series) are changed by clicking the 

appropriate ‘Change’ button and selecting from the colour dialog box that appears. All 

other options are applied by clicking the appropriate check/radio box. 

3.4 Exporting 

Once a ‘grabbed’ graph has been re-rendered, tools for Exporting the Graph Image and 

Exporting the Raw Data are available through the ‘File’ menu. 
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3.4.1 Exporting the Graph Image 

Once an image has been traced and re-rendered, selecting ‘Export Graph As Image’ 

from the ‘File’ menu allows it to be saved to file. First a ‘Choose Your Resolution’ 

dialog box appears, allowing the dimensions of the saved image to be defined. Upon 

confirming these options (by clicking the ‘Tick’ box) a ‘Save File’ dialog box will open. 

From here a filename, destination folder and file type (either *.bmp, *.jpg, *.gif or *.png) 

can be specified. Clicking ‘Save’ will then save the re-rendered graph image with its 

current stylings (titles, colours etc.) to the specified location. 

3.4.2 Exporting the Raw Data 

Once an image has been traced, selecting ‘Export Graph As Data File’ from the ‘File’ 

menu will open a ‘Save File’ dialog box. From here a filename, destination folder and 

file type can be specified. Clicking ‘Save’ will save grabbed data in a comma separated 

value text format, with two columns (for x- and y- value) and a row for each data 

point, grouped into series. 

4 Help and Support 

Selecting ‘About’ from the ‘Help’ menu of Grab Grabber will open an information 

panel containing a link to the Graph Grabber page on the Quintessa website. From here 

it is possible to download the latest version of the software and user guide. 

The page also contains an email link for feedback and bug reports. Emails should be 

sent to StevenBenbow@quintessa.org with the subject ‘Graph Grabber’. 

5 Disclaimer 

Graph Grabber v1.5.5 is provided 'as is', without any representation or endorsement 

made and without warranty of any kind whether express or implied, including but not 

limited to the implied warranties of satisfactory quality, fitness for a particular 

purpose, non-infringement, compatibility, security and accuracy. Quintessa has made 

every possible effort to ensure that Graph Grabber v1.5.5 is free from viruses and 

spyware. However, no responsibility whatsoever is accepted for any damage caused 

by its application. 
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